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Intellectual Property and Copyright
This document includes registered and unregistered trademarks. All trademarks displayed are the trademarks of
their respective owners. Your use of this document does not constitute or create a licence or any other right to use
the name and/or trademark and/or label.

This document is subject to copyright owned by [[[Undefined variable MyVariables.CompanyNameFull]]]. You agree
not to copy, communicate to the public, adapt, distribute, transfer, sell, modify or publish any contents of this
document without the express prior written consent of MadCap Software.

Disclaimer
The contents of this document is provided on an “as is” basis. No representation or warranty (either express or
implied) is made as to the completeness, accuracy or reliability of the contents of this document. The manufacturer
reserves the right to change designs or specifications without obligation and without further notice. Except as
otherwise provided, all warranties, express or implied, including without limitation any implied warranties of
merchantability and fitness for a particular purpose are expressly excluded.

General Warning
This product must only be installed, configured and used strictly in accordance with the General Terms and
Conditions, User Manual and product documents available from MadCap Software. All proper health and safety
precautions must be taken during the installation, commissioning and maintenance of the product. The system
should not be connected to a power source until all the components have been installed. Proper safety precautions
must be taken during tests and maintenance of the products when these are still connected to the power source.
Failure to do so or tampering with the electronics inside the products can result in an electric shock causing injury
or death and may cause equipment damage. MadCap Software is not responsible and cannot be held accountable
for any liability that may arise due to improper use of the equipment and/or failure to take proper precautions. Only
persons trained through an MadCap Software accredited training course can install, test and maintain the system.

Liability
You agree to install, configure and use the products strictly in accordance with the User Manual and product
documents available from MadCap Software.

MadCap Software is not liable to you or any other person for incidental, indirect, or consequential loss, expense or
damages of any kind including without limitation, loss of business, loss of profits or loss of data arising out of your
use of the products. Without limiting this general disclaimer the following specific warnings and disclaimers also
apply:

Fitness for Purpose
You agree that you have been provided with a reasonable opportunity to appraise the products and have made
your own independent assessment of the fitness or suitability of the products for your purpose. You acknowledge
that you have not relied on any oral or written information, representation or advice given by or on behalf of
MadCap Software or its representatives.

Total Liability
To the fullest extent permitted by law that any limitation or exclusion cannot apply, the total liability of MadCap
Software in relation to the products is limited to:

i. in the case of services, the cost of having the services supplied again; or
ii. in the case of goods, the lowest cost of replacing the goods, acquiring equivalent goods or having the goods

repaired.

Indemnification
You agree to fully indemnify and hold MadCap Software harmless for any claim, cost, demand or damage
(including legal costs on a full indemnity basis) incurred or which may be incurred arising from your use of the
products.

Miscellaneous
If any provision outlined above is found to be invalid or unenforceable by a court of law, such invalidity or
unenforceability will not affect the remainder which will continue in full force and effect. All rights not expressly
granted are reserved.
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Codes and Standards Information for Air Sampling Smoke Detection
We strongly recommend that this document is read in conjunction with the appropriate local codes and standards
for smoke detection and electrical connections. This document contains generic product information and some
sections may not comply with all local codes and standards. In these cases, the local codes and standards must
take precedence. The information below was correct at time of printing but may now be out of date, check with your
local codes, standards and listings for the current restrictions.

FCC Compliance Statement
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, the user is encouraged to try to correct the interference by one
or more of the following measures; re-orientate or relocate the receiving antenna, increase the separation between
the equipment and receiver, connect the equipment to a power outlet which is on a different power circuit to the
receiver or consult the dealer or an experienced radio/television technician for help.

FDA
This product incorporates a laser device and is classified as a Class 1 laser product that complies with FDA
regulations 21 CFR 1040.10. The laser is housed in a sealed detector chamber and contains no serviceable parts.
The laser emits invisible light and can be hazardous if viewed with the naked eye. Under no circumstances should
the detector chamber be opened.

FM Hazardous Applications
3611 Hazardous Approval Warning: Exposure to some chemicals may degrade the sealing of relays used on the
detector. Relays used on the detector are marked “TX2-5V”, “G6S-2-5V” or “EC2-5NU”.

Xtralis detectors must not be connected or disconnected to a PC while the equipment is powered in an FM Division
2 hazardous (classified) location (defined by FM 3611).

FM Approved Applications
The product must be powered from VPS-100US-120, VPS-100US-220 or VPS-220 only.

ONORM F3014
ONORM F3014, transport times for all tubes (including capillaries) must not exceed 60 seconds from any hole. This
means that the pre-designed pipe networks that include capillaries cannot be used.

AS1603.8
The performance of this product is dependent upon the configuration of the pipe network. Any extensions or
modifications to the pipe network may cause the product to stop working correctly. You must check that ASPIRE
approves alterations before making any changes. ASPIRE is available from your Xtralis distributor.

AS1851.1 2005
Maintenance Standards. Wherever this document and the AS1851.1 differ, AS1851.1 should be followed in
preference to this document.

European Installations
The product must use a power supply conforming to EN54: Part 4.
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License Agreement
Definitions
In these Conditions, unless the contrary intention appears:

l Documentationmeans any data, information or documentation supplied or made available to Licensee,
including but not limited to any operating or user manuals or online help documentation relating to the
Software;

l Intellectual Property includes all copyright, and all rights in relation to registered and unregistered
trademarks (including service marks), registered designs, registered patents and confidential information
(including trade secrets and know-how), and all other rights resulting from intellectual activity in the
industrial, scientific, literary or artistic fields;

l Youmeans any person who installs or uses the Software and any person on whose behalf the Software is
installed or used.

l Software means ASPIRE.
l Xtralis means Xtralis Pty Ltd.

Grant of License
a. Xtralis grants to You a non-exclusive, non-transferable license (without the right to sublicense except as set

forth below) to install and use the Software and to use the Documentation strictly in accordance with the
terms of this agreement (License).

b. In consideration of the grant of the License, You agree to comply with the terms of this agreement.

Permitted use
You may:

a. use the Software and Documentation strictly to aid in the design of an Xtralis pipe network installation
b. make hardcopies of reasonable portions of the Documentation for your internal use or otherwise as

permitted under copyright laws; and
c. make one backup copy of those parts of the Software that are supplied in electronic form, but only as strictly

required for backup and security purposes.

Restriction on License
You must:

a. not sell, reverse engineer, disassemble, decompile, copy, modify, translate, network, publish,
commercialize, rent, lease, assign, transfer, loan, sub-license or otherwise distribute all or part of the
Software or Documentation, or any adaptation, modification or derivative of all or part of the Software;

b. not disclose the Software or Documentation to any third party without the consent of Xtralis;
c. not use the Software for any unlawful purpose;
d. not allow any employees, agents or any other third parties to do anything inconsistent with the terms of this

License;
e. You may not alter or remove any of Xtralis’s copyright or proprietary rights notices or legends appearing on

or in the System;
f. not remove, obscure or interfere with any copyright, acknowledgment, attribution, trade mark, warning,

disclaimer statement, rights management information or serial numbers incorporated in or otherwise applied
in connection with the Software or Documentation.

g. The Software may contain or be derived from materials of third party licensors. Such third party materials
may be subject to restrictions in addition to those listed in this License. You agree that any third party
supplier shall have the right to enforce this License with respect to such third party’s software; and

h. use the Software and Documentation only for your personal use.

Intellectual Property
All intellectual property rights in the Software and Documentation are owned by Xtralis Pty Ltd and or its licensor.
You must notify Xtralis Pty Ltd immediately if you know or suspect any unauthorised use, or violation of any
Intellectual Property.

Updates
Xtralis may, in its sole discretion, provide You with new versions of the Software or Documentation. Xtralis may
charge You an additional fee for the provision of any new versions of the Software or Documentation, which will
otherwise be provided on the terms and conditions of this License. You understand that it is Your obligation always
to use the latest available version of the Software or Documentation.

Warranties
Xtralis provide the Software 'as is' and to the extent permitted by law, Xtralis excludes all representations and
warranties in respect of the Software and Documentation. In respect of any representations or warranties that
cannot be excluded by law, Xtralis’s liability is limited, at its option, to replacement of the Software and/or
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Documentation, supply of equivalent Software and/or Documentation or refund of the purchase price. You hereby
consent to the foregoing and release Xtralis and its affiliates, service providers, suppliers, and dealers from any and
all liability arising from such action.

Limitation of Liability
a. To the extent permitted by law, Xtralis excludes all liability (including liability for negligence) for any indirect

or consequential expenses, losses damages or costs incurred by You in any way connected with the
Software (including any system designs generated by or connected with use of the Software) or
Documentation.

b. To the extent permitted by law, Xtralis limits it total aggregate liability (including liability for negligence) for
any damage arising under or in connection with this License or the use of the Software or Documentation to
the replacement value of the software by Xtralis.

Release and indemnity
a. You release Xtralis and its employees and agents in respect of all liability for loss, damage or injury which

may be suffered by You arising from its use of the Software or Documentation; and
b. You indemnify Xtralis and its employees and agents in respect of all liability for loss, damage or injury,

which may be suffered by any person arising from that person’s use of the Software or Documentation
supplied to You.

Term and Termination
This License is effective on the day you first download or otherwise access the Software and/or documentation and
will continue for so long as you continue to use the Software.

a. Xtralis may terminate this license with immediate effect if You breach this license or become subject to any
form of insolvency administration.

b. Either you or Xtralis may terminate this license by giving the other party 14 days' notice in writing.
c. Upon termination of this License, You must immediately cease using the Software and Documentation and

erase all copies under your control. Xtralis reserves the right at any time and from time to time to charge for
use of the Software, and modify or discontinue, temporarily or permanently, the Software (or any part
thereof) with or without notice. You agree that Xtralis will not be liable to you or to any third party for any
modification, suspension or discontinuance of the Software.

d. Accrued rights or remedies of either party are not affected by the termination of the license.

Waiver
Failure or delay by either party to enforce at any time any of the rights, powers or remedies of this License will not
be construed or deemed to a waiver of that party’s rights under this License. A waiver of a right, power or remedy
must be in writing and signed by the party giving the waiver.

Entire Agreement
This License records the entire agreement between you and Xtralis, and supersedes all earlier or
contemporaneous agreements and representations about its subject matter.

Applicable Law
This License is governed by the laws of the state of Victoria, Australia and each party irrevocably submit to the
jurisdiction of courts of Victoria, Australia.

Severability
A term or a part of a term of this License that is illegal or unenforceable may be severed from this Agreement and
the remaining terms or parts of the terms of this License continue in force.

Compliance
Software and technical information delivered under this License may be subject to U.S. export control laws and
those of other countries. You agree to strictly comply with all such laws and regulations, and you will be solely
responsible for obtaining any import, export, re-export approvals and licenses required for such Software any
technical information, and retaining documentation to support compliance with those laws and regulations.
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Document Conventions
The following typographic conventions are used in this document:

Convention Description
Bold Used to denote: emphasis.

Used for names of menus, menu options, toolbar buttons
Italics Used to denote: references to other parts of this document or other

documents. Used for the result of an action.

The following icons are used in this document:

Convention Description
Caution: This icon is used to indicate that there is a danger to equipment.
The danger could be loss of data, physical damage, or permanent
corruption of configuration details.

Warning: This icon is used to indicate that there is a danger of electric
shock. This may lead to death or permanent injury.

Warning: This icon is used to indicate that there is a danger of inhaling
dangerous substances. This may lead to death or permanent injury.

Contact Us
UK and Europe +44 1442 242 330
D-A-CH +49 431 23284 1
The Americas +1 781 740 2223
Middle East +962 6 588 5622
Asia +86 21 5240 0077
Australia and New Zealand +61 3 9936 7000

www.xtralis.com
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1 Introduction to ASPIRE
ASPIRE helps you rapidly evaluate the performance of proposed pipe network solutions.
It allows you to enter site specific information and then automatically test a range of possible sample hole
solutions. ASPIRE also allows you to configure the design parameters to suit your local fire codes and
standards. The default settings can also be configured to accommodate installation or materials restrictions
such as hole sizes.
Through the use of ASPIRE and the good design principles outlined in the VESDA Pipe Network Design
Guide you will be able to determine good designs, and you can then select themost appropriate design for
your project.
ASPIRE allows you to automatically create a bill of materials, an installation data pack (IDP), and a 3D model
of the pipe network.
For ease of access, information on the definition and use of fields in the software is covered in the ASPIRE
online help. Press the F1 key while on any screen for further details.

1.1 Product Guide
The ASPIRE Product Guide has been written for pipe network designers. It will assist you to understand and
use the ASPIRE software.
This Guide covers the installation, configuration of default settings and the use of the ASPIRE software to
design and test pipe network solutions.
The guide contains information on the possible ways to resolve limitations in a pipe network design, and to
arrive at an acceptable solution.
It is assumed that you have already attended Xtralis accredited training and are knowledgeable about local
codes and standards that apply to system design.
For further information on the theory of pipe network design, refer to the VESDA Pipe Network Design Guide.

1.2 Where Does ASPIRE Fit in the Customer Life Cycle?
Before you can successfully use ASPIRE you need to:

l Attend Xtralis accredited training in the use of ASPIRE
l Have a good understanding of the principles of pipe network design
l Have a good understanding of the local codes and standards
l Conduct a site survey to determine the size, scope and obstructions at the customer site

Once you have completed the ASPIRE design you will be able to create a bill of materials and an installation
data pack.



VESDA ASPIRE Product Guide VESDA by Xtralis

4 www.xtralis.com

1.3 Features
ASPIRE contains the following features:

l Navigation Tree to browse the whole project rather than a single detector
l Pipe wizards for the simple set up of common pipe designs
l Region specific defaults to suit local pipe specifications
l AutoBalance to automatically set hole sizes
l Introduction of groups for target sensitivity setting
l 3D isometric models to aid design and installation
l Bill of Materials generated for the final pipe network solution
l Installation Data Pack captures the installation information
l Commissioning Report to generate all forms used to commission the system
l Set multiple detector alarm thresholds within a detector
l Sampling Point Sensitivity tab to confirm EN54-20 compliance

ASPIRE also has the ability to build your own application defaults which suit:
l Customer design specifications,
l Local codes and standards, and
l Project conditions.

1.4 What ASPIRE Can Do
ASPIRE will allow designers to;

l Design systems with multiple aspirated smoke detector units
l Design systems with pipe networks fitted to the sample inlet ports of detectors
l Design systems with up to 25 holes per pipe (depending on the detector type)
l Design systems which use up to 20 bends per pipe (depending on the detector type)
l Design systems containing inlet sample pipe runs with multiple branch points
l Set multiple threshold levels within a detector

Remember that while ASPIRE can accept very large complex pipe designs, each of the detectors has a
physical limit to the amount of protection they can offer.

1.5 What ASPIRE can NOT do
It will not fix a poor design by re-configuring your pipe runs. We trust that you have laid the pipes in a way to
accommodate project requirements.
For information on improving the way you configure pipe runs, refer to the Pipe Network Design Guide and
attend Xtralis accredited training.
ASPIRE can check that your designmeets your configured set of criteria and defaults but does not check that
these will meet the local codes and standards for the customer site. It is expected that you, as the designer,
will use the correct codes and standards.



VESDA by Xtralis VESDA ASPIRE Product Guide

www.xtralis.com 5

2 Installing ASPIRE
Copies of the ASPIRE software can be obtained from Xtralis. The latest copy of the ASPIRE software can be
downloaded from www.xtralis.com.
From time to time the ASPIRE range of software is upgraded with new functions. These improvements come
from the results of extensive laboratory research and as a result of customer feedback. We highly recommend
that you update your copy of ASPIRE every six months. If you have not updated in the last six months please
download a copy from www.xtralis.com today.
The instructions for installation are slightly different depending on how you received your copy of ASPIRE.
Close all other programs before installing ASPIRE as they may interfere with the installation process.

2.1 System Specification
ASPIRE is designed to run onWindows 7 andWindows 10 operating systems.

2.1.1 Installing ASPIRE from a CD
Insert the CD into the CD ROM drive. Wait 10 seconds, if nothing happens run SETUP.EXE on the CD.
The Installation splash screen will appear. Click Next > and follow the instructions on the screen.

2.1.2 Installing ASPIRE from a downloaded file
Double-click on the downloaded file and the installation files will be decompressed onto your computer. The
installation will automatically start and display the installer splash screen, click Next > and follow the
instructions on the screen.

2.2 Running ASPIRE
Double-click the VESDA ASPIRE icon on your desktop, or alternatively, select Start | Programs | Xtralis |
VESDA ASPIRE.
If you have an ASPIRE file then double-clicking it will start ASPIRE and load the file.
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3 Creating a New Project
Each time you start ASPIRE it will automatically open a new project. A project contains the detectors, pipes
and holes required for a project.
Click on the project icon in the tree view and enter the name of the project.

3.1 Adding a Detector
To add a detector to your project, right-click the project name in the tree view and select Add Detector. You
should give each detector ameaningful name so that the installer will easily be able to determine the detector
location. To name each detector, right-click, select Rename Detector and enter the name for the detector.
Use the General tab that appears on the Detector View to choose the settings for the new detector.
Note: IFT-15 detectors do not require modeling, as tube lengths are the same for a given installation.

3.1.1 Adding a Note
ASPIRE allows you to store information on any element of a design. This information is included in the
Installation Data Pack which will be printed out and given to the installers, so it is useful to include details that
will assist the engineers to correctly identify and install the detector.
To add or edit notes for a detector, right-click and select Edit Notes. Enter the information into the pop up
window and select OK to save the details.

3.2 Adding a Pipe
There are a number of different ways to add pipes to a project. To create the first pipe you can right-click the
detector in the tree view, select Add Pipe and use the PipeWizard.
Once the first pipe has been created you can either continue to use the PipeWizard or you can quickly and
consistently create duplicates of the pipe using copy and paste. To duplicate an existing pipe, select the pipe
in the tree view, press Ctrl+C. You have now copied all the details of the pipe. In the tree view, select the
detector where you want to copy the pipe, press Ctrl+V. Another way to duplicate a pipe is to drag a pipe with
the Ctrl key down. The plus that appears on the drag icon indicates that a copy (rather than amove) operation
will occur.

Figure 3-1: Add a Pipe
Remember to name each of the pipes to help the installer install the pipes in the right place. To name a pipe,
right-click on the pipe in the tree view and select Rename Pipe. Enter the pipe name then press Enter. Notes
can also be used to record extra information on a pipe.

To add or edit notes for a pipe, right-click and select Edit Notes. Enter the information into the pop
up window and select OK to save the details. To add or edit notes for an individual subsection of
pipe, click on the relevant cell in the Pipe View and click theEdit Item Note button.

Once the pipe has been added you canmodify any aspect of the pipe network to suit your customer
environment. Refer to The Pipe View for details.

3.2.1 Adding Extra Bends
Perform the following steps to insert an extra bend into a pipe.

Select the pipe in the tree view window, select the item where you want the new bend to be
inserted, click theBend button.
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3.2.2 Changing Pipe Direction
You can change the pipe direction by using a branch, elbow or bend. Perform the following steps to change the
direction of a pipe branch.
Select the pipe in the tree view window, then select the Direction of the bend or elbow in the Direction column
in the Pipe View window. A drop-down list of directions will open and allow you to select from the following
directions:

Code Direction

U Up

D Down

L Left

R Right

F Forward

B Back

LD Left & Down

Table 3-1: Changing Bend or Elbow Direction

3.2.3 Modifying Hole Sizes
Perform the following steps to change the size of a hole.
To modify one hole:
Select the pipe in the tree view window, then select the piece of pipe that contains the hole. Select the hole
from the Hole Diameter column and a drop-down list will offer all the hole sizes that can be used in this project.
To use a new hole size for just this project:
Select the project in the tree and add the hole size to the list in theHole Sizes field. Alternatively, you can add
a new hole size when setting theHole Diameter for any sampling point by typing in the required hole size.
When the size you have entered is not part of the default set of hole sizes amessage box will pop up to let you
know, and also let you confirm that this hole size can now be used for other pipes in this project.
To change the default hole sizes:
To add a new hole size to the default list for future projects, select Tools | Preferences | Project Defaults
and enter the new size in the Hole Sizes field.

3.2.4 Modifying Pipe Diameter
Reducing the size of a pipe can improve the sensitivity of holes at the end of a pipe network.

To reduce the diameter of the pipe, select the pipe in the tree view window, then select the piece
of pipe where the reducer is to be installed. Select the reducer button, and edit the pipe diameter
size to suit your needs.

3.3 Testing for a Good Design
As you enter the details for the pipe network it is a good idea to frequently save your results. Select File |
Save, enter the name of the project and click Save.

If you have specifically entered information about the size and distance between holes, click the
calculate button (or hit the F5 key) to see if the designmeets your design criteria. While
calculating if the design will work, ASPIRE will not modify any of your configuration.

If you click the Auto-Balance button, ASPIRE will begin automatically modifying your hole sizes
and the detector’s fire threshold in an attempt to find a solution that satisfies all design
constraints.

After Calculating or Auto-Balancing your design ASPIRE will indicate if your design will work*.
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The numbers are color coded, green is good, red requires further investigation. For further information on the
color coding refer to The Colors used in ASPIRE.
If the design is not accepted, refer to Resolving Common Site Design Problems for assistance in improving
the design.
Note: * Your design will only be as good as the quality of your site survey.

3.4 Saving your Results
At any point during design you can choose to save the project file. Select File | Save to save. Project files can
be shared with other people. To share your project file with users who do not have the latest version of
ASPIRE installed, select File | Save As and save the file as the appropriate version.
Auto-Save
Auto-save will capture and save your project at regular intervals (the default is 5minutes) to the standard
program data folder (usually C:\ProgramData\Xtralis\Aspire) as the file aspireAutoSave.asp. This is really an
ASPIRE file so to reload it youmust first rename it to have the .ASPIRE extension. To enable Auto-save and
set its properties go to Tools | Preferences | General.
Note: The ProgramData folder is hidden by default onWindows 7. To view and access it go toControl

Panel > Appearance and Personalization > Folder Options > Show hidden files and folders and
click on the radio buttonShow hidden files, folders, and drives.

Figure 3-2: Show ProgramData Folder

3.5 Generating Reports
A complete set of instructions for the installer can be produced by selecting File |Generate IDP. The
Installation Data Pack contains 3D schematics with all the pipe lengths and sizes for the installer to be able to
successfully install the project.

You can generate a BOM (Bill of Materials) by selecting the project and clicking the Bill of
Materials button. The BOM contains a list of the components required to install the project,
individual detectors, and each pipe.

Select File | Commissioning Report to generate a Commissioning Report. The Commissioning Report will
contain all of the forms used to commission your system.
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4 Creating an Effective Design
While you can put all the site survey information into ASPIRE and get an acceptable design, how can you tell
if it is the best design? An effective design requires the designer to have detailed knowledge about many
disciplines. At aminimum you should;

l Have a good understanding of the local codes and standards for the site
l Attend Xtralis accredited training
l Study the VESDA Pipe Network Design Guide and applicable Application Design Guides
l Enter into ASPIRE the site survey information which has been gathered using the principles of good
design

l Test the results for several different possible designs for the site. This 'What if...' testing process
allows you to test the design under different operating conditions, such as with different hole sizes or
with the use of Auto Balance.

Provided you have configured ASPIRE with the rules of your local codes and standards, any 'Green' design
will work. For information on how to configure application defaults, refer to Configuring Your Applications and
Defaults.

4.1 Achieving EN 54-20 Compliance
EN 54-20 is a European standard which classifies aspirating smoke detectors into Class A, B or C. Class C is
normal sensitivity, Class B is enhanced sensitivity, and Class A is very high sensitivity. The classification
system specifies themaximum concentration of smoke required at a sampling point (to trigger an alarm) and
themaximum transport time. The hole sensitivity target is themaximum smoke level allowable to achieve the
detector threshold setting.

4.1.1 EN 54-20 Defaults
ASPIRE uses the transport time and hole sensitivity targets that have been approved for a range of Xtralis
detectors. The tables below show the transport time targets and hole sensitivity targets respectively.
ASPIRE allows you to choosemultiple threshold levels for one detector. When this occurs, ASPIRE uses the
transport time of the selected classification for the Fire 1 threshold. ASPIRE indicates which classes a
detector complies with.
If any sampling holes do not meet the target hole sensitivity, ASPIRE displays the detector threshold level
needed to achieve target hole sensitivity. Youmay choose to apply the recommended detector threshold
level. Youmay also switch off the EN 54-20 class andmanually modify the transport time or target hole
sensitivities. If those values render the detector non-compliant, ASPIRE displays the hole sensitivities in red
text.

Detector Class A Class B Class C
VESDA-E VEU 70 90 110
VESDA-E VEP 60 90 110

VESDA VLP, VESDA VLC 60 90 120
VLF-250 60 60 60
VLF-500 90 90 90

VESDA VLS 75 75 90

Table 4-1: EN 54-20 transport time targets (seconds)

Detector Class A Class B Class C
VESDA-E VEU 1.5 3.0 10
VESDA-E VEP 1.5 3.0 8.0

VESDA VLP, VESDA VLC, VESDA VLF 1.5 4.5 10
VESDA VLS (non-scanning) 1.5 4.5 10

Table 4-2: EN54-20 target hole sensitivities (%obs/m) used by ASPIRE
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4.1.2 Multiple Threshold Sensitivity
ASPIRE allows you to specify a particular detector threshold class to achieve EN54-20 compliance. ASPIRE
will calculate the hole sensitivity needed to achieve compliance. Youmay also specify multiple threshold
levels for each detector (for example Alert = Class A, Alarm = Class B and Fire 1 = Class C) so that very early
warning of low levels of smoke occurs. Table 4 shows the default detector alarm threshold used by ASPIRE.
ASPIRE allows you to choose which detector alarm thresholds are displayed and printed. Selected thresholds
are printed in the installation data pack and on the commissioning form (the Fire 1 threshold is always
displayed and printed). The threshold levels must increase in the order Alert < Action/Pre-Alarm < Fire 1/ Fire
< Fire 2. The difference between two thresholds must not be less than 0.005% obs/m. Theminimum Alert
threshold value is 0.005% obs/m (0.025% obs/m for VLF detectors).

Threshold Level Default Detector Alarm Threshold
Fire 2 2.0% obs/m

Fire 1/Fire 0.2% obs/m
Action/Pre-alarm 0.14% obs/m

Alert 0.08% obs/m

Table 4-3: The default detector alarm thresholds used by ASPIRE

4.1.3 Hole Aggregation
When a sampling hole is not able tomeet the required hole sensitivity target, youmay choose to aggregate
holes. The hole aggregation option allows you to aggregate holes so that smoke detected across a set of
aggregated holes (with clean air at other holes) will trigger the detector. In this way the aggregated group of
holes acts as a large sampling hole. This allows the detector to respond earlier when smoke is present across
a wide area. ASPIRE calculates the number of holes that need to be aggregated to achieve target sensitivity.
Refer to the following section for more information.
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4.2 Advanced Design Using Groups
The concepts and best practices used in this section are for system designers who wish to have amore
detailed technical understanding of the ASPIRE software. These features should only be used after you have
attended Xtralis accredited training.
The use of groups allows a collection of holes to be treated as an integrated super-hole so that smoke from all
the holes in the group aggregates together to provide greater sensitivity than would be provided by a single
hole. The ‘Aggregate Sensitivity’ refers to the smoke level required at all holes in the group (with clean air at all
other holes) to trigger the detector.

Legend
A Normal Protection

B Group over air grille

Figure 4-1: Grouped holes
Groups can also be used for a collection of holes that are in a slightly different environment to the other holes
in the pipe network. The use of groups allows you to place different aggregate sensitivity constraints on each
group. So, if you have pipes which are protecting a room, and also have four holes over an air grille, you can
place the air grille holes in one group, so they are treated consistently, and place the other holes in other group
(s). This allows you to set a different aggregate sensitivity at the return air grille to the ceiling.
Holes should only be grouped if:

1. They are in the same room.
2. The holes aremonitoring the same grille (unless the grilles are close together and feed into the same

duct).
3. Are of the same type and so have the same performance target. For example, holes monitoring a grille

with high air-flow should not bemixed with holes that aremonitoring the room where there is normal air
flow. Instead the grille and room holes should be placed in separate groups.

Generally, the holes belonging to different groups should be on separate pipes. This especially applies to
groups of different types. So, for the above example, the group of holes monitoring a grille should be on a
different pipe from the holes that aremonitoring the room. If this is not possible then the different groups
should at least be on completely separate branches.
Groups can be assigned a standard type so that their balance and sensitivity settings are standardized. See
TheGroup Types Dialog for more details on defining the standard Group Types.
Auto Balance will treat holes within a group consistently and optimize the balance of each group
independently from other groups.
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5 Resolving Common Site Design Problems
AutoBalancemay return a number of concerns about the proposed pipe network design. The following
information explains each of the concerns and provide suggestions on how to resolve the issue.

5.1 The Group Sensitivity Needs to Improve
The aggregate sensitivity of a group of sample holes has dropped below your target sensitivity.

l Check that the target sensitivity is correctly set, it may be that your default settings are set too high
and a lower sensitivity is acceptable.

l Check to see that the sample points outside the group are not extreme and that a relatively consistent
hole size has been used. The group sensitivity may have dropped due to the sensitivity of other points
being too high.

l Check that holes belonging to other types of groups are on separate pipes, or at least on separate
branches.

l Check that you have selected the right number and set of sample points.

5.2 The Transport Time Needs to Improve
It will take too long for a smoke sample to travel from the sample point to the detector. Transport time is the
time taken for smoke entering a sample hole to reach the detector. It does not include the detector alarm delay
period, which can be configured for each detector.

l Check that the target transport time is appropriate for this design. Many local codes and standards
require amaximum transport time of 90 seconds. The VESDA laser detector default for systems
typically require the sample to be detected within 60 seconds. If your transport time is between 60 and
90 seconds, check to see if the transport time is acceptable to your local codes and standards.

l VEU, VLP and VLS detectors allow you to increase the aspirator speed which will increase the speed
of air in the pipe network. To change aspirator speed select the detector in the tree view, if the aspirator
speed is displayed in the details panel, increase the speed and recalculate the design to see if the
transport time is now acceptable.

l Using larger holes in the pipe endcaps will improve the transport time (but may lower the sample point
sensitivity for all holes in the pipe).

l Shortening the length, and increasing the number of pipes covering an area will normally reduce the
transport time.

If the system has already been installed and you are using ASPIRE to troubleshoot you should also check:
l That the pipe network that has been installedmatches the pipe network that has been designed and
tested in ASPIRE.

l All of the holes have actually been drilled, and are in the right location.
l For breaks or blockages such as excess glue in pipe joints.

5.3 The Flow Balance Needs to Improve
Sensitivity (and air flow) varies from one hole to another. Holes with low flow require higher smoke levels and
somay miss amarginal smoke event, while holes with high flow are sensitive to low smoke levels and so
may generate false alarms. Thereforeminimizing the range of hole flows minimizes the risks of missed events
and false alarms. The flow balance is ameasure of this flow variation. The balance is defined as a ratio of
flows, the hole with the least flow is compared with the hole with the largest flow. So a balance of 70% means
that every hole has at least 70% as much flow as the best hole. Hence the higher the balance, themore
uniform is the flow through all the holes.
If all holes are the same size, the flow rate through each hole reduces with distance from the detector, many
designs offset this by increasing hole size as distance increases.
If the balance of your system is too low you can:

l Check that the size of the sampling holes used is relatively the same. A small increase in the size of
holes is to be expected as you get further away from the detector. Large differences in holes size will
need to be reviewed to improve the balance.
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l Use the AutoBalance function to determine the appropriate hole sizes.
l Reduce the size of the endcap hole.
l If the pipe has a collection of sampling points in the pipe and capillaries, remember that the capillary
holes will need to be slightly larger than the hole size used in the pipe.

l You could also try a different pipe configuration (for example, use an H configuration instead of one
long pipe).

5.4 The Minimum Hole Flow Needs to Improve
There is not enough air being sampled from some sample holes. ASPIRE is warning that the sensitivity of the
hole will be prone to fluctuation as a result of air currents in the protected environment.
If a hole has low flow you can improve the flow by:

l Checking the hole sizes being used. Increasing the hole size and re-calculating should resolve this
problem.

l Increasing the aspirator speed (where supported by the detector eg VEU, VEP, VLP) and the flow of air
in the pipe network. Select the detector in the tree view. If the aspirator speed is displayed in the details
panel increase the speed and recalculate the design to see if the transport time is now acceptable.

5.5 The Minimum Hole Pressure Needs to Improve
There is not enough air being sampled from a sample hole(s) due to lack of air pressure. Low pressuremay
alsomake the sample flow vulnerable to cross draughts.

l Check the hole sizes being used. Decreasing the hole size and re-calculating should resolve this
problem.

l Increase the aspirator speed and so increase the speed of air in the pipe network. To change the
aspirator speed, select the detector in the tree view; if the aspirator speed is displayed in the details
panel increase the speed and recalculate the design to see if theminimum hole pressure is now
acceptable.

l The pipemay be too long. If the pipe is protecting a room, try using an H configuration pipe network
instead.

l Theremay be toomany holes or the holes may be too large for the type of detector chosen. Either
select amore powerful detector or add another detector to the project or reduce the size of the holes on
the pipe.

5.6 The Hole Sensitivity Needs to Improve
Hole Sensitivity is the smoke level required at a particular sample point - assuming clean air at the others - to
produce a fire alarm at the detector. Notice that as this number increases, the detector requires more smoke -
so the system is less sensitive.

l Relax the Target Hole Sensitivity
l Lower the EN 54-20 (or UL) target classification, for example, from A to B
l Increase the hole sizes
l Decrease the detector threshold
l Reduce the number of holes
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6 The ASPIRE Interface
This section contains information about each of the components of the interface and how to work with them.

6.1 The ASPIRE Window

Legend
A Menu Bar
B Toolbar Buttons
C Tree View
D Details Pane

Figure 6-1: Project Screen of ASPIRE
l Title Bar: Shows the project name or the name of the loaded file.
l Menu Bar: Shows the available menus. Refer to TheMenus for further information.
l ToolBar Buttons: Offers a faster way to perform alterations without having to use theMenus. Place
your cursor over the button for popup information on each button. Refer to The Toolbars for further
information.

l Tree View: Shows the current configuration of the proposed project. As you add extra detectors and
pipes this view will change to reflect your changes. Refer to The Tree View for further information.

l Details Pane: This window presents different sets of options to allow you to configure the pipe
network. For details on the options presented on the first screen, refer to The Detector View.

l 3D View: This window shows the pipe network associated with whatever detector is selected in the
tree view.

6.1.1 The Tree View
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Figure 6-2: The Tree View
The Tree View allows you to browse across all of the detectors and pipes that will be used in the project.
Being able to look over all the details that are used in a project site allows you to cut and paste sections to
rapidly and consistently build new sections of a customer site. An example of what may appear in your Tree
View is shown below.
Project
The project has a red cross next to it as one of the pipes for Detector 3 is unacceptable. All detectors and
pipes must be within your design criteria for the project to be accepted.
Detector 1

This detector has had somemodification to its pipe work and the project has not been recalculated
yet. Select Tools | Calculate to recalculate the flows and pressures within the pipe network and
check if themodifications are within your design criteria

Detector 2

This detector and its pipe network have been tested and found to be acceptable.

Detector 3
The pipe connected to detector three is outside your design criteria. You need to investigate, modify the pipe
network (or your defaults) and recalculate to clear the cross.
Detector 4
The pipe connected to detector four is acceptable but has warnings. Expand the detector settings to find the
warning and if possible modify your design to avoid it.

6.2 Interacting with the ASPIRE Interface
There aremany ways of performing actions in ASPIRE, for example if you want to duplicate an existing pipe
on a detector, select the pipe then;

l click theCopy button, select the pipe in the tree view and click Paste Insert
l click Ctrl+C, then select the detector and click Ctrl+V
l select Edit | Copy, select the pipe, then select Edit | Paste Insert
l drag the pipe while holding down the Ctrl key. A + will appear on the drag icon to indicate
that the original pipe will be duplicated.

You can place the pipe in the desired location using the drag and drop feature.
To keep things simple, this document will only describe onemethod of performing a particular action. It is
anticipated that youmay discover other ways to perform an action that youmay prefer to use.

6.2.1 The Colors used in ASPIRE
While working on a site plan you will see that different figures appear in different colors. The colors are used to
let you know if a figure is acceptable, not acceptable, suspect, or not applicable.

l Green: The figure is acceptable and within the parameters you have set for the project.
l Blue: The value is unknown. Usually applies to calculated values that depend on flows and pressures
and indicates that the design has changed since the last flow calculation was run.

l Red: Indicates that the figure is outside the parameters you have specified for your project.
l Amber/Orange: This is a warning. Youmay be pushing the boundaries of your project and should
review the warning. If possible make changes to remove the warning but in some cases you can
proceed with caution.

l Black: This figure is used to indicate a value setting that does not require validation.
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6.3 The Menus
Menus can be accessed at the top of the ASPIRE screen.

6.3.1 The File Menu
The file menu allows you to create new project files, open existing files, and save the files you are working on.

TheGenerate IDP (Installation Data Pack) option provides an easy way to gather and store all the information
that the installers will need to install the pipework and commission the system.
TheGenerate BOM (Bill Of Materials) option provides an easy way to create a list of all thematerials required
to install your project.
TheCommissioning Report option generates a report containing all of the forms used to commission the
system.
Recently opened files are listed. Clicking on any of these will open them.
Exitwill close ASPIRE.
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6.3.2 The Edit Menu
The Edit functions can help you rapidly and consistently build a complex model
by duplicating sections of an existing design. Elements copied to the clipboard
can now be pasted to other instances of ASPIRE.
Undowill undo the last operation. There are 8 levels of undo.
Redowill reapply the operation that has just been undone.
TheCut, Copywill copy the currently selected element to the clipboard. Paste
will replace the selected element with the clipboard element. Pasting a
detector over an existing detector will only replace its properties. Pasting a
pipe over another pipe will also replace all sections under that pipe. ThePaste
Insert function allows you to duplicate an element inside a pipe network.
Fill Down applies to fields on the Pipe table. If a range of cells is selected then
the top value is copied into the lower selected cells. If only the top cell is
selected then the fill applies to all lower cells.

Figure 6-3: Result of applying Fill Down
Copy All is used to copy all cells from the table to the clipboard so that they
can be pasted into Excel orWord tables. This copy will copy all columns
including those that are currently hidden. It will also copy all rows even the
rows that are not in the scrolled range.

Figure 6-4: Copy All copies all table cells to the clipboard. Even those rows
that are outside the scrolled range will be copied to the clipboard

Delete removes the currently selected element.
TheEdit Notes andRename options allow you to add extra information to
different sections. The name of each section and any notes will be printed out
on the IDP and will assist the person installing the system.
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6.3.3 The View Menu
The view menu allows you to display or hide the Shortcut Toolbar and the Palette Toolbar. Refer to The
Toolbars for further information.

Show/Minimise 3D View: selecting this option will either undock the 3D View
andmove it in its own frame or will close the frame and dock the 3D view in the
lower left of themain window. The 3D View allows you to see a 3-D view of the
detector and pipework and directly edit elements of the network. Refer to The
3D View section for further information.
Scan : The VLS detector has the ability to test samples from all pipes and then
scan each individual pipe once smoke has been detected. If you have chosen
to use a VLS you can use this option to test your pipe network with scanning
enabled (ticked) or disabled (no tick). We recommend that you use the detector
in normal mode (no scan) first, then turn scanning on later. For further
information on Scanning detection see the VLS Product Guide.

6.3.4 The Insert Menu
Adding a detector is one of the first functions you will need to perform when
designing a new site. If multiple detectors are required for a site you can add
further units by selecting this option.
Once you have added a detector you can add pipe runs to suit your site
conditions. SelectingAdd Pipewill start The Pipe Network Choice Screen of
the PipeWizard. For further information, refer to The Pipe Network Choice
Screen of the PipeWizard.
For assistance see the VESDA Pipe Network Design Guide and Creating an
Effective Design.
The followingmenu items refer to fittings that can be inserted into a pipe.
These are the same as shown on the Palette toolbar and are enabled when the
pipe (or pipe section) is selected on the tree. Refer to the Palette Toolbar for
more information.

6.3.5 The Tools Menu
l Calculate: Once you havemade changes to your pipe network you can
recalculate the flows and pressures by selecting this option.
Note: You only need to run this Flow Calculator when the detector is
showing the stale calculation status .

l Auto Balance: This is one of themain features of ASPIRE. Once you
have built your basic pipe network design for the site you can use this
feature to automatically set your hole sizes. It will test a range of hole
sizes and endcap sizes and the detector fire threshold then adjust these
settings to offer themost effective solution for this pipe network
configuration. Undowill return to the original hole sizes and fire
threshold.

l Preferences: Sets the ASPIRE system settings and Project defaults
so that future designs are createdmore efficiently, andmore
consistently. Refer to The Preferences Dialog for further information.

l Application defaults: This allows you to set up default sets for
applications that you commonly use. For further information, refer to
Configuring Your Applications and Defaults.

l Group Types: This allows you to setup settings for standard types of
groups.
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6.3.6 The Help Menu
l Contents:Selecting the contents option will display the table of
contents for the online help for ASPIRE.

l Help:Displays the first page of the online help system for ASPIRE.
l Contact us: This option displays the contact details for support.
l About ASPIRE:Displays the version details for the copy of ASPIRE
that you are currently running.
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6.4 The Toolbars
There are two toolbars available in ASPIRE. To enable or disable the toolbars, select the View Menu and
toggle the shortcut or palette toolbar options.

6.4.1 The Shortcut Toolbar

Displays some regularly used features.

Create New Project: This button allows you to create an entirely new pipe network project. If you have
not already saved your design, you will be prompted for the location and file namewhere the design is to
be stored.
Open Existing Project: This button allow you to open existing ASPIRE configurations.

Save Design: This button saves your current project configuration. If you have not already saved your
design, you will be prompted for the location and file namewhere the design is to be stored.
Generate Installation Data Pack: This button allows you to get an Installation Data Pack so that the
installers get all the details of your current pipe network design.
Generate Bill of Materials: This button allows you to generate a Bill of Materials that lists all
components required to build the pipe network for the project or the selected detector.
Generate Commissioning Report: This button allows you to generate a Commissioning Report that
contains the forms and information used to commission the system.
Undo:Will undo the last operation. Tere are 8 levels of undo.

Redo:Will reapply the operation that has just been undone.

Cut Current Selection:Copies the currently selected element to the clipboard and then deletes it.

Copy Current Selection: Copies the currently selected element to the clipboard.

Paste item into Design: The element in the clipboard is pasted over the currently selected element so
that it replaces the selected element. For detectors the properties are replaced but the pipes and groups
are unaffected.
Insert Item Before Current Selection: This button allows you to paste a copied element before the
currently selected element. If the clipboard element normally sits beneath the selected element, then
the copied element will be added to the end of the selected element’s children.
Fill Down: Fill lower cells with top cell value.

Delete:Removes the selected element.

Edit Note: This button allows you to add notes to any element of the pipe network design. These notes
will be included in the IDP (Installation Data Pack) which can be given to the installers. Use notes to
name and help the installers distinguish between different pipes.
Calculate: Once you havemade changes to your pipe network click this button to recalculate all of the
ASPIRE figures based on your current parameters.
Auto Balance: If you have entered the details of your proposed design and the calculate function is
returningAmber/Orange orRed results, selecting this button will cause ASPIRE to automatically
adjust hole size settings to see if a valid configuration is possible that satisfies the design constraints.
Auto Balance will test a variety of hole sizes, endcap sizes and fire thresholds.
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6.4.2 The Palette Toolbar

Allows you to insert different components into the pipe network. The components in this toolbar will change to
suit different regions.
To insert any element, select the location in the project tree window or 3D view, then click the toolbar
component. Adding bends and other joints that redirect airflow disturb the normal air flow inside the pipe
network. For information on the impact of using different types of joints please see the VESDA Pipe Network
Installation Guide.

Add Detector: This button allows you to add a detector to your site design.

Add Pipe: This button allows you to add extra pipes to a detector in your site design.

Add Hole: This button lets you add a hole to your pipe run.

Add Capillary: This button lets you add a capillary to your pipe network design.

Add HASP: This button lets you add a Heat Activated Sampling Point.

Add 45° Elbow: This button lets you add an elbow to your pipe network design.

Add Bend: This button lets you add a bend to your pipe network design.

Add Small Radius Bend: This button lets you add a small radius bend to your pipe network design.

Add T Piece: This button lets you add a T piece to your pipe network design.

Add Reducer: This button lets you add a pipe reducer to connect different sized pipes.
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6.5 Views
The following views are available in ASPIRE. Some views are only available when a specific type of object is
selected.

6.5.1 The Project View

Figure 6-5: Project View
This is the first screen to be displayed when starting a new project. It allows you to record administrative
information about the project.

l Project: This field stores the name of the project. If you use File | Save As to save a copy of this
project the name in this field will change to reflect your changes.

l Address: The address of the customer site. Enter enough detail for the installer to install the system in
the correct location. If there aremultiple buildings or levels within buildings then these details should
also be recorded to reduce the chance of errors occurring.

l Contact: Enter the contact details of the customer who will make the final decisions on the fire
systems to be installed.

l Installer: Allows you to record who will be installing the system.
l Calculated By: Allows you to record your name so that if people look at the project information at a
later date and have any questions they will be able to contact you. You can use this field to also record
your phone or email address tomake it easier for the installers to contact you.

l Date:By default this field records the date when the project was first started.
l Pipe Type:Defines the pipe fittings that will be used in this pipe network. The regions are America,
Europe and Asia/Pacific.

l Units: Show if you are currently using US imperial or Metric units of measurements. Refer to The
Preferences Dialog for details.

l Altitude: The altitude above sea level affects the air pressure in the detector view. Thinner air at higher
altitudes will increase the time it takes to get a smoke sample to the detector (transport time).

l Hole Sizes:A list of the hole sizes that are being used in this pipe network. Hole sizes can be added to
this list but can only be removed from the list if they are not being used.

l Enforced Limit:Specifies what sampling point sensitivity standard to apply. The ‘Custom’ option
allows you to specify your own sensitivity and transport time limits.
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6.5.2 The Detector View
The Detector view displays all the information about the detector selected in the tree view.

The General Tab of the Detector View

Legend
A Detector selected B List of available detectors
C Aspirator speed D Application
E Endcap usage F Detector details
G Inverted detector selection

Figure 6-6: TheGeneral tab of the Detector View
l Detector Type: This list allows you to select the type of detector for your customer site. As new
detector models become available you will be able to select them from this list. If you are looking for a
particular model and it is not listed, please update your copy of ASPIRE to the latest version.

l Detector Name: This field displays the name of the detector you have selected. If your customer site
requires pipe networks for an office, atrium, and warehouse you can name each different detector to
avoid confusion.

l Aspirator Speed: Some detector models allow you to adjust the aspirator speed. Increasing the
aspirator speed will normally reduce the transport time for smoke samples reaching the detector.

l Endcap Usage: Endcap usage determines how you wish to use endcaps.
l Create a balanced design: This increases the sensitivity of detection for each hole as more air
comes into the pipe network through sample holes rather than the endcap vent. By default 3mm holes
are used.

l Use endcaps to reduce transport time: This option increases the hole sizes in the endcaps so that
the air from the sample holes is transported faster to the detector. By default 4mm holes will be used.

l Apply EN54-20 Limit: The EN 54-20 class to apply to this design. If the project has defined a different
Approvals standard then this drop down list will show the relevant classifications.

l Application: If you find that you are regularly creating a similar type of site from the factory defaults,
you should consider creating your own sets of defaults to allow you to design customer sites more
consistently and faster. This drop-down list allows you to select to use any sets of defaults that you
have created. For information on creating your own personalized set of application defaults for each
detector please see The Detector Tab of the Application Defaults Dialog.

l Fire Threshold: The amount of smoke required at the detector to activate the fire alarm (Fire 1).
l Temperature: The expected average temperature of the air being sampled by the detector.
Temperature affects the viscosity and density of air, hotter air travels faster. Enter an estimate of what
the expected average temperature will be.
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l Relative Altitude: The relative offset of this detector from the altitude specified for the project. For a
tall building the project may specify the altitude of the city and this relative altitude field may specify the
height above ground level of the detector location. This setting has minimal impact on the flow
calculations and can generally be ignored. It is used to calculate the Absolute Pressure.

l Absolute Pressure: The expected average air pressure at the detector based on the sum of the
project altitude and the detector’s relative altitude. Air pressure affects the transport time.

l System Flowrate: The amount of air collected by the detector per minute. (Not shown for detectors
that contain multiple aspirators.)

l Manifold Pressure: The amount of suction pressure (in Pa) in the detector manifold.
l Total Pipe Length: This is the total length of all pipes connected to the detector. If this number is red
you will need to decrease the size of the pipe network for the detector to work effectively. Alternatively,
you can select a different Detector Type as another model may be able to support your proposed pipe
network.

l Number of sample points: All detector types have an upper limit on the number of sample points that
can be effectively used. Having toomany sample points connected to a detector will reduce the
sucking pressure to an unacceptable lower limit that may compromise detection.

l Maximum Transport Time: This is themaximum acceptable amount of time for a smoke sample to
travel from a sample hole to the detector. If an EN 54-20 class is specified then this field will show the
relevant time and will not be editable.

l Minimum Hole Flow Rate: This is theminimum acceptable amount of air to be sampled by each hole
per minute.

l Exhaust Length: The total length of exhaust pipe.
l Exhaust Diameter: The diameter of the exhaust pipe.
l Exhaust Pressure Drop:Calculated estimate of the pressure drop across the exhaust.
l Inverted Detector: For some customer sites, it may bemost practical to install the detector in an
inverted (upside-down) position. Check this box if the detector will be inverted.

The Pipe Summary Tab of the Detector View

Figure 6-7: The Pipe Summary Tab of the Detector view
The pipe summary tab displays the current pipe configuration. This tab gives a summary of the pipe network
connected to the detector. As extra pipes are added you will need to select Calculate to update these details.
Some figures, such as the distance between holes, may vary. When this occurs the range of distances will be
displayed instead of a figure. Select the pipe in the tree view to see the details.

l Pipe Length: The total length of pipe connected to the detector.
l First Position: The distance from the detector to the first hole.
l Number of Sample Points: Total number of sample holes for the pipe.
l Hole Spacing: Distance between holes.
l Pipe Internal Diameter: The ID (Internal Diameter) of the pipe.
l Capillary Internal Diameter: The ID (Internal Diameter) of any capillaries.
l End Vent Diameter: The size of the hole in the endcap.
l Ambient Pressure: The relative difference in suction pressure between the location of the sample
point and the location of the detector exhaust (ignoring height effects). If the detector exhausts air back
into the same area it samples, the ambient pressure should be set to zero (0) Pa.

l Maximum Transport Time: Themaximum calculated transport time for an air sample to travel from a
sample point to the detector.
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l Sector Pressure: The suction pressure for each pipe at the detector.
l Sector Flow: The amount of air collected by each pipe.

The Group Details Tab of the Detector View

Warning: Hole Groups should not be used when trying to achieve EN 54-20 compliance. Instead, use the
Sampling Point Sensitivity tab.
TheGroup Details tab is used to create groups of sampling holes that work together to simulate a large, more
sensitive sampling point. For further information refer to Advanced Design Using Groups.

Figure 6-8: TheGroup Details tab of the Detector view
l Add: Allows you to add a new group.
l Delete: Allows you to delete a group. Holes assigned to the deleted group are returned to the Default
group. (The default group cannot be removed). Undo can be used to bring back a deleted group.

l Rename: Allows you to rename a group. (The Default Endcap groupmay not be renamed).
l Endcap Usage:Determines the use of endcap in pipe networks.
l Create a balanced design: This increases the sensitivity of detection for each hole as more air
comes into the pipe network through sample holes rather than the endcap vent. The endcap is also
used to sample the air. By default 3mm holes are used.

l Use endcaps to reduce transport time: This option increases the hole sizes in the endcaps so that
the air from the sample holes is transported faster to the detector. By default 4mm holes will be used.
The endcap is not used to sample air in this mode.

l Group Type:Allows the group settings to be set to a standard group type.
l Max Target Aggregate Sensitivity: The upper limit of smoke detection for the group of holes.
l Min Target Aggregate Sensitivity: The lower limit of smoke detection for the group of holes.
l Contribution ratio (%): The proportion of sampling points within the group that would be expected to
sense a fire event. For example, in a large room the smoke from a fire event at one end of the roommay
only reach half of the sample points. In this case the Contribution Ratio would be set to 50%.

l Applied Max Aggregate Sensitivity: The upper limit of smoke detection that is applied to this group.
It is theMax Target Aggregate Sensitivity * Contribution Ratio.

l Applied Min Aggregate Sensitivity: The lower limit of smoke detection that is applied to this group.
It is theMin Target Aggregate Sensitivity * Contribution Ratio.

l Target Suction Pressure: The lower limit of suction pressure for holes in the group.
l Target Balance: The least acceptable balance for the group of holes.
l Exclude from AutoBalance: The option allows you to protect your settings from being altered when
the AutoBalance function is run.

l Pipe/Section: The details for each sample point in the pipe network. Click the radio button for each
hole to collect them into groups. Holes can bemoved from one group to another by selecting the radio
button in the other group.

l Number of holes:Count of the number of sample points. (Ignores blocked or open endcaps).
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l Flow Share (%): The proportion of the detector’s flow in this group.
l Aggregate Sensitivity: Aspirating Smoke Detectors have a unique feature that allows the detector to
collect small samples of smoke frommany different sample points and check to see if the total of the
smoke exceeds the smoke threshold. If two traditional point detectors (which do not use aspirating
smoke detection) are exposed to a small amount of smoke - say one detector receives 48% of its
threshold, the other 52%, there is no way they can combine this information. But an aspirated detector
can aggregate smoke received through several holes. Aggregate Sensitivity is defined for a group of
holes. It is the uniform smoke level required at each hole (with clean air at all others outside the group)
to produce a fire alarm at the detector. For example, if you are using two pipes to protect a room, and a
third pipe to cover a return air grill, youmight assign all holes in the first two pipes to the “room” group,
and the remainder to “air grille” group. Then you can ask ASPIRE to determine what is the aggregate
sensitivity of the room, and also the sensitivity for the air grille.

l Balance: The lower limit of balance expected for the group of holes. This value is usually set to 70% or
higher because the holes in the group should have similar characteristics. For further information refer
to The Flow Balance Needs to Improve.

l Suction Pressure (least): The lower limit of suction pressure (in Pa) for the sample hole.
l Notes: You can attach notes to groups. This information will be included in the Installation Data Pack
which will be printed out and given to the installers, so it is useful to include any details that will assist
the engineers to correctly identify and install the detector.
To add or edit the notes for a group, select the group by clicking on the group header and click on the
Edit Notes toolbar button. Enter the extra information into the pop up window and select OK to save
the details.

Sample Point columns.
Any of the following sample point columns can be shown (or hidden) on the Group view by right clicking on the
column headers and then clicking on the relevant column name.

Figure 6-9: Context menu used to show/hide columns
The order of these columns can be changed using amouse drag.
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The Sampling Point Sensitivity Tab of the Detector View

Figure 6-10: The Sampling Point Sensitivity tab of the Detector view
l Display Threshold: Check the check box to display/hide the threshold. If checked, the threshold will
be displayed and printed in the IDP. The checkbox for Fire 1 is not enabled because Fire 1 cannot be
deselected.

l Alarm Threshold Setting: The smoke level at which the detector will report an alarm.
l Apply EN 54-20 Target: The EN 54-20 classification used to set the target hole sensitivity.
Note: This field will change depending on the Approvals code that is defined for the project.

l Target Hole Sensitivity: Themaximum allowable smoke level at an individual hole in order to achieve
the detector threshold setting. This value is automatically adjusted when you select an EN 54-20
target. The higher the target hole sensitivity, the less sensitive the detector will be.

l Maximum Transport Time:Shows themaximum time that is allowed by the EN 54-20 class for
smoke to reach the detector sensing element.

l Hole Aggregation (to achieve Target Sensitivity): A hole aggregation number greater than 1
indicates that ASPIRE has aggregated holes in order to achieve the target sensitivity. Youmay accept
the design with aggregated holes (ASPIRE will show the pipe section values in red, and red crosses
next to the pipes in the tree view) or youmay modify your design so that hole aggregation is 1. For more
information, refer to Hole Aggregation.

l EN 54-20 Class Achieved: This row displays the EN 54-20 Class achieved for each threshold level.
l Alarm Threshold needed (to achieve Target Sensitivity): The detector threshold setting that will be
triggered if any single hole detects smoke at the Target Sensitivity level.

l Safety Factor (% reduction in alarm threshold): Themargin to allow when setting the threshold. It
is recommended to always use amargin here to allow for slight variations in installation and operating
conditions.

l Alarm threshold to be applied: The estimated Alarm Threshold reduced by the specified Safety
Factor.

l Apply needed Detector Threshold?: Adjusts the Detector Threshold setting to the value that will
trigger an alarm any single hole if smoke is detected at the Target Sensitivity level.
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6.5.3 The Pipe View
Selecting any pipe, or section of pipe, in the project tree will display the details.

Figure 6-11: Pipe View
This panel displays all the calculated pipe details. Figures displayed in cells shaded gray are your calculated
values.
The top of the panel shows pipe properties. The bottom of the panel shows the details for each section.
You can customize the columns that appear on the Pipe View display. Right-click on the heading of any
column in the pipe view and click on the name of a column in the drop-down list to show or hide that column.

Summary Information

l Total Pipe Length: The total length of all sections of pipe. Total Pipe Lengthmay be altered by
clicking on the relevant cell in the Relative Distance column and entering a new value. The Total Pipe
Length will be updated to show the new value. The total pipe length ignores sections of pipe with
blocked endcaps such as those sections used for cleaning or maintenance checks.

l Sector Pressure: The suction expected at the start of the pipe.
l Pipe Flowrate: The amount of air expected to be sampled by this pipe (liters per minute).
l Ambient Pressure: The difference in pressure between this pipe and the detector exhaust outlet. A
positive value indicates that the air pressure for the room sampled by the pipe is higher than the air
pressure at the detector exhaust outlet.

l Number of Sample Points: The total number of sample points in this pipe.

Detailed Information

l Item: The name of each section of pipe.
l Type: Type of each item of pipe in the design. You can change holes for capillaries, andWater Traps
for Endcaps by clicking on the component that you wish to change and select another component from
the drop-down list.

l Direction: Indicates the direction that a bend or elbow will take. For further information on the different
directions see the pop-ups by placing your mouse pointer over any item in the list.

l Absolute Distance: Distance from the start of the pipe (detector).
l Relative Distance: Distance relative to the previous item in the list.
l Hole Diameter: The diameter of the hole for this sampling point.
l Capillary Length: This changes the length of the capillary tube for this capillary. For a drop pipe this is
the pipe length in the drop pipe.

l Transport Time: The time it will take for an air sample tomove from the sample point to the detector.
(Calculated by ASPIRE).

l Pressure: The suction pressure at the sample point. This should be at least 25 Pa. Cross drafts in the
sampling areamay require more suction pressure. (Calculated by ASPIRE).

l Flow: The amount of airflow from the sample point (L/min). (Calculated by ASPIRE).
l Flow%: The percentage of the total air flow that will come from this sample point. (Calculated by
ASPIRE).
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l Hole Sensitivity: The amount of smoke required at this hole with clean air entering all other holes to
cause the detector to alarm. Higher numbers indicate less sensitivity. (Calculated by ASPIRE).

l Pipe Diameter: ID (Internal Diameter) of sampling pipe.
l Capillary Diameter: ID (Internal Diameter) of the capillary. For drop pipes this is the pipe diameter.
l Intersection Pressure: The pressure (in Pa) at the point where the capillary intersects the pipe.

6.5.4 The 3D View
Minimizing and Floating
The 3D View may be shown in its own frame by selecting themenu item View | Show 3D View or by clicking

on the expand button .
The 3D View can be re-docked by selecting themenu item View | Minimise 3D View or by clicking on the
Minimize or Close buttons on the top right of the 3D frame.

Figure 6-12: 3D View
View
The viewed network may bemoved by holding down the left mouse button and dragging it to a new location.
The network may be rotated by holding down the right mouse button andmoving themouse.
Themouse scrollbar is used to zoom in and out on the pipe network view.
There are four standard orientations that can be accessed by clicking a button. They are:

l Isometic: where the viewer is behind, above and to the right of the detector.
l Front: where the viewer is behind the detector looking forward.
l Plan: where the viewer is above the detector looking down.
l Side: where the viewer is to the right of the detector looking to the left.

The Auto Frame checkbox centers the pipe network within the field of view and adjusts the zoom so that the
pipe network fits within the viewed window. This checkbox is also available on the docked view.
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Visible Pipes
When a detector is selected then it is shown along with all its pipes. When you select a pipe or a section or
fitting within a pipe then you can choose to show or hide other pipes. If you choose to show the Selected pipe
then other pipes are shown as transparent. The transparency (or opaqueness) of these other pipes is
controlled by a slider. The blue bar on the slider indicates the range of transparency where other pipes may be
selected by clicking on them. When the slider is below the blue bar the other pipes will appear ghosted and
may not be selected.

Edit Functions
The table to the right of the 3D View shows the properties of the currently selected element so that you can
edit properties without needing to leave the 3D View.
If you select a bend or tee, or the section immediately before the bend or tee, then you can change the
direction using the following keyboard shortcuts where they are relevant.

l U/D Up or down
l F/B Forward or backwards
l L/R Left or right

You can remove elements by selecting them and clickingDelete or clicking on the delete toolbar button.
You can Copy and Paste Insert items by selecting an item and copying it to the clipboard using Ctrl-C (or the
toolbar Copy button) and Paste Insert using Ctrl-I (or the toolbar Paste Insert button).
You can insert new fittings by selecting the location and clicking on the relevant fitting icon on the Palette
toolbar.

Selection
The selection in the 3D view is linked to the tree so that changing the selection in the tree (or the pipe table)
changes the selected items on the 3D view. Similarly changing the selection on the 3D view will update the
tree and table.
Clicking on a section in the 3D view will select the item at the end of the section. For example, to select a
bend you need to click on the section immediately before the bend.
Double clicking on an item will select its containing pipe section. This is defined as all items after the current
item and all items before the current item until a branch (or tee) or the detector is encountered.
When theGroup Details or Sampling Point Sensitivity tabs are selected on the Detector’s detail pane, then
selecting items on the 3D view will not update the tree but will select the sample point row in the relevant
table. Double clicking on a sample point on the 3D view when theGroup Details tab is visible will cause the
group containing that sample point to be selected along with all the other sample points in that group.
Similarly, selecting a group by clicking in the column heading of the group in the Group Details table will cause
the 3D view to select all sample points in that group.
Copies of the views can be included in the IDP (Installation Data Pack) which is given to installers.
The colors used are similar to the pipe view, green is good, red requires further investigation. For further
information on the color coding refer to The Colors used in ASPIRE. The 3D view also uses cyan to show the
currently selected element.
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6.5.5 IDP (Installation Data Pack)
Select File | Generate IDP to see the Installation Data Pack for your site.
Once you have finished designing your site, the IDP contains all the site specific information that the installer
needs to know to correctly install your design. This information includes project level information, drawings,
pipe network specifications, and all the notes you have added to your design.

IDP Project
The first section of information is specifically related
to the project. This section of the IDP includes the
altitude above sea level, the date the IDP was
printed, and the units of measure to be used by the
project. The list of hole sizes reduced to those
actually used in the design lets the installer know
what drill bits are required.

IDP Detector
The second section contains information about the
type and configuration of each of the detectors that
will be used on the site. The detector section also
contains a summary of the pipe networks that will be
connected to each detector.
The IDP will include a table showing themultiple
threshold sensitivities you have selected.

IDP 3D Diagrams
The third section contains 3D schematic diagrams for
each pipe leading away from the detector. The
inclusion of 3D diagrams is optional (but
recommended) in the IDP.
Note: Color coding is used in these diagrams. If

there are any red sections of pipe, it
indicates that the current configuration will
not meet your design criteria and further
investigation is required before you can
send the IDP to the installer.

IDP Pipe Summary
The next section of the IDP contains a summary of
the parameters for each pipe. The figures listed in this
sectionmay also be used by the person
commissioning the system to determine the expected
air pressure in each pipe.
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IDP Pipe Section
Finally, the IDP contains a section which gives the installer detailed information on the configurations required
for this section of the pipe network.
Details such as the expected pressure for each hole can be used by the person commissioning the system to
check that the installed pipe network matches the design created in ASPIRE.

Figure 6-13: IDP - Pipe Section Information

6.5.6 BOM (Bill of Materials)
A Bill Of Materials can be generated for a single
detector or for the entire project. Select a detector or
the project, then select File |Generate BOM to see a
list of all the parts required for each detector in your
project.

Bill Of Materials

The first section of this report lists all the project
details.

Detector

This section of the report lists all the part numbers
required to order the parts for each detector.

Project Totals

This section of the report is a summary of all the parts
required for the entire project (if BOM is generated for
entire project).

Commissioning Report

Select File | Commissioning Report or click on the
Generate Commissioning Report toolbar button to
generate the Commissioning Report.
The Commissioning Report contains all the forms
used to commission the system. For details of the
forms, refer to the relevant detector guides.
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7 The Pipe Wizard
The PipeWizard automates the addition of new pipes to a detector. It will lead you through all of the steps
required to configure a pipe. To access the pipe wizard select a detector, then select Insert | Add Pipe. Once
you have completed the creation of a pipe, you can view the details of any pipe by selecting it in the tree view.
The PipeWizard knows themaximum allowable parameters for each type of detector. The PipeWizard will
recommend that you use amore appropriate detector if you attempt to configure a pipe network which is
beyond the recommended capabilities for the type of detector you have chosen.
If youmust use that type of detector you should review your pipe runs on the floor plan andmodify your pipe
network to a better design.

7.1 The Pipe Network Choice Screen of the Pipe Wizard

Figure 7-1: PipeWizard
Enter a name and select which type of pipe is to be added to the detector.

l Simple:Pipes that may havemany bends but do not branch intomore than one pipe.
l Simple branch:Pipes that are used to fill in a section of a room which is not covered by other pipe
work.

l H configuration:Pipes that are recommended for small, square rooms as they have good balance and
uses less pipe than equivalent single pipes.

l Multiple Branch:Pipes that are used in large rooms or rooms with odd shapes.
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7.2 The Simple Pipe Screen of the Pipe Wizard
To access the PipeWizard select a detector, then select Insert | Add Pipe.

Figure 7-2: Simple Pipe Screen
The default configuration settings can bemodified by Tools | Application defaults | Simple Pipe Wizard.
These settings allow you to configure a pipe whichmay have bends but does not split into more than one pipe.

l Total Pipe Length: Enter the length of the pipe.
l Number of bends before the first hole: Enter the number of bends before the pipe network reaches
the first sample hole.

l First Hole Position: Set the distance to the first sample hole in the pipe.
l Hole Separation: Set the distance between sample holes in the pipe. If you are using a variety of
different distances between holes, enter themost common distance here andmanually edit the
distances when the pipe wizard has finished.

l Number of Holes: The number of holes that will be generated based on the values you have entered.
(Calculated by ASPIRE.)

l Number of Sample Points: This adds the endcap hole to the list of holes. (Calculated by ASPIRE.)
l Back <: Returns you to the previous screen of the pipe wizard.
l Next >: Moves you on to the next screen in the pipe wizard.
l Finish: Selecting this button will cause the pipe wizard to automatically accept the default values for
any options which you have not already set.



VESDA by Xtralis VESDA ASPIRE Product Guide

www.xtralis.com 39

7.3 The Simple Branch Screen of the Pipe Wizard
To access the PipeWizard select a detector, then select Insert | Add Pipe.

Legend
A Section 1
B Section 2
C Section 3

Figure 7-3: Simple BranchWizard Screen
These settings can bemodified by Tools | Application defaults | Simple Branch.
These settings allow you to configure your branched pipe produced by the wizard.

l Number of bends before the first branch: Enter the number of bends before the pipework will start
branching.

l First Hole Position: Set the distance to the first sample hole in the pipe.
l Hole Separation: Set the distance between sample holes in the pipe.
l Section 1 Length: Set the length of the first piece of pipe. (A)
l Section 2 Length: Set the length of the second pieces of pipe. (B)
l Section 3 Length: Set the length of the third pieces of pipe. (C)
l Total Pipe Length: The length of all the parts of pipe. (Calculated by ASPIRE.)
l Total Pipe Length: The combined length of all sections of pipe based on the values you have entered.
l Number of Holes: The number of holes that will be generated based on the values you have entered.
(Calculated by ASPIRE.)

l Number of Sample Points: This adds the endcap holes to the list of holes. (Calculated by ASPIRE.)
l Back <: Returns you to the previous screen of the pipe wizard.
l Next >: Moves you on to the next screen in the pipe wizard.
l Finish: Selecting this button will cause the wizard to automatically accept the default values for any
options which you have not already set.
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7.4 The H Configuration Screen of the Pipe Wizard
To access the PipeWizard select a detector, then select Insert | Add Pipe.

Legend
A Section 1
B Section 2
C Section 3

Figure 7-4: H Configuration Screen of the PipeWizard
This kind of pipe network can provide well balanced sampling for small, square rooms.
These settings can bemodified by Tools | Application defaults | H Configuration.
These settings allow you to configure a H branched pipe (also called a small multiple branch).

o Number of bends before the first branch: Enter the number of bends before the pipework will start
branching.

o First Hole Position: Set the distance to the first sample hole in the pipe.
o Section 1 Length: Set the length of the first piece of pipe (A).
o Section 2 Length: Set the length of the second pieces of pipe (B).
o Section 3 Length: Set the length of the third pieces of pipe (C).
o Endcaps only : Have 4 sample points, one in each endcap. (Option not available when using endcaps

to reduce transport time).
o 8 Holes: This will normally consist of a hole in each Section 3 pipe, and a second sample hole in the

endcap.
o Total Pipe Length: The combined length of all section of pipe based on the values you have entered.

(Calculated by ASPIRE.)
o Number of Holes: The number of holes that will be generated based on the values you have entered.

(Calculated by ASPIRE.)
o Number of Sample Points: This adds the endcap holes to the list of holes. (Calculated by ASPIRE.)
o Back <: Returns you to the previous screen of the pipe wizard.
o Next >: Moves you on to the next screen in the pipe wizard.
o Finish: Selecting this button will cause the pipe wizard to automatically accept the default values for

any options which you have not already set.
Tomodel a 4-hole configuration with the holes in Section C, choose the 8-hole configuration, and set the
Endcap hole diameter to 0 units.
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7.5 The Multiple Branch Screen of the Pipe Wizard
To access the PipeWizard select a detector, then select Insert | Add Pipe.

Legend
A Section 1
B Section 2
C Section 3
D Section 4
E Section 5

Figure 7-5: Multiple Branch “Moose Head” Screen
These settings can bemodified by Tools | Application defaults | Multiple Branch. These settings allows
you to configure the defaults when you add aMultiple branched pipe (refer to The Pipe Network Choice
Screen of the PipeWizard).
These settings allow you to configure amultiple branch pipe (also called a 'moose head' pipe).

l Number of bends before the first branch: Enter the number of bends before the pipework will start
branching.

l First Hole Position: Set the distance to the first sample hole in the pipe.
l Hole Separation: Set the distance between sample holes in the pipe.
l Section 1 Length: Set the length of the first piece of pipe (A).
l Section 2 Length: Set the length of the second pieces of pipe (B).
l Section 3 Length: Set the length of the third pieces of pipe (C).
l Section 4 Length: Set the length of the fourth pieces of pipe (D).
l Section 5 Length: Set the length of the fifth pieces of pipe (E).
l Total Pipe Length: The combined length of all sections of pipe based on the values you have entered.
(Calculated by ASPIRE.)

l Number of Holes: The number of holes that will be generated based on the values you have entered.
(Calculated by ASPIRE.)

l Number of Sample Points: This adds the endcap holes to the list of holes. (Calculated by ASPIRE.)
l Back <: Returns you to the previous screen of the pipe wizard.
l Next >: Moves you on to the next screen in the pipe wizard.
l Finish: Selecting this button will cause the pipe wizard to automatically accept the default values for
any options which you have not already set.
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7.6 The Pipe Properties Screen of the Pipe Wizard
If you wish to use a variety of different size hole diameters then enter themost common size in the hole
diameter field and once the wizard is finished you will need tomanually edit the sizes. To edit the sizes, select
the section of pipe in the tree view, click on the appropriate cell in the Hole Diameter column, and edit the size
by entering the value, or by choosing a diameter from the drop-down list.

Figure 7-6: Pipe Properties Screen
Pipe Configuration

l Pipe Diameter : Enter the ID (Internal Diameter) of the pipe network.
Capillary

l Use Capillaries : Check this checkbox if you would like to use capillaries.
l Capillary Diameter : If you choose to use capillaries, enter the internal diameter of the capillaries.
l Capillary Length : If you choose to use capillaries, enter their length.

Sampling Points
l Hole Diameter : The standard size of holes in the pipe network. You canmanually change the size of
individual holes once the PipeWizard has finished.

l Endcap Diameter : The standard size of endcap holes in the pipe network. You canmanually change
the size of individual holes once the PipeWizard has finished.

Environment
Ambient air pressure is any difference in air pressure that occurs between the sample holes and the detector’s
exhaust outlet. If the pipe samples air from an area that has a higher or lower air pressure than the detector it
will affect the flow rate, transport time and other variables in your design. Differences in air pressure can be
caused by fan forced air being pumped into an area such as a computer room, cabinets that need to be air
cooled, and some high security environments.
Generally, if there are no air tight doors in a building this figure should be zero (0). If air tight doors are fitted,
ask the buildingmanagement for access to the air conditioning specifications as it should show any
differences in pressure.
In computer rooms or other mechanically ventilated areas, it is possible for individual pipes to be located in
areas where the ambient atmospheric pressure is higher (+ve ambient) or lower (-ve ambient) than the
pressure that the detector is exhausting to. The ambient pressure differential relevant to each pipe can be
entered. It is not usual for pressure differentials to exceed 25 (Pa). At this pressure, doors become difficult
either to open or to close, or loose ceiling tiles may lift. An aspirator exhaust pipemay be fitted to relieve
pressure or noise and the details of the exhaust, both pipe length and diameter should be entered into the
detector settings.
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l Ambient Pressure: Enter the pressure differential between the pipe network and the detector’s
exhaust outlet. This will be zero unless there are air-tight areas between the pipe network and detector.

l Back <: Returns you to the previous screen of the PipeWizard.
l Finish: Selecting this button will cause the PipeWizard to automatically accept the default values for
any PipeWizard options which you have not already set.

7.7 The Application Defaults Dialog
If you find that you are regularly creating a similar type of site from the factory defaults, you should consider
creating your own set of application specific defaults to allow you to design customer sites faster andmore
consistently.
To create a new set of application defaults select Tools | Application Defaults | New…. You will be
prompted to enter a namewhichmust be unique. Then you will see the dialog that lets you specify a set of
defaults. Select a tab and edit the defaults. When you have finished editing all the desired defaults on all of the
desired tabs, click Save.
You have now created a new set of application defaults. These will now be available for all future detectors.
To use them in the existing project you will need to save the project and re-open it. On theGeneral tab of the
Detector View, select your set of application defaults from theApplication drop-down list and you are ready
to start.

7.7.1 The Detector Tab of the Application Defaults Dialog

Figure 7-7: The Detector tab of the Application Defaults dialog
l Maximum Transport Time: The upper allowable limit of time that it can take tomove a smoke sample
from a sample hole to the detector.

l Minimum Hole Flow Rate: The lower allowable limit of airflow from the pipe network.
l Temperature: This is the expected average air temperature where the detector and the pipe network
will operate. Temperature affects the density and viscosity of air, the hotter the air the shorter the
transport time. As an example, VLP transport time for a single one hundredmeter pipe run with 5.0mm
hole at end:

Temperature -20 C +20 C +60 C
Transport Time 86 Seconds 81 Seconds 78 Seconds

Note: For information about minimum ormaximum operating environments for each detector please see
the VESDA Pipe Network Design Guide or refer to themanual for that detector. Transport times are
also dependent on hole sizes.
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7.7.2 The Pipe Tab of the Application Default Dialog

Figure 7-8: The Pipe tab of the Application Defaults dialog
When you run the PipeWizard you will be able to change any of the default values entered below.

l Ambient Pressure: The default pressure differential between the pipe network and the detector’s
exhaust outlet. This will be zero unless there are air-tight areas between the pipe network and detector.

l Pipe Diameter: The default ID (Internal Diameter) of the pipe. Leave this blank to use the diameter of
the standard pipe used in the current region.

l Hole Diameter: The size of sample points in the pipe.
l EndCap Diameter: The diameter of the vent in the endcap.
l Tube Diameter: The diameter of capillary tubes. Leave this blank to use the diameter of the standard
capillary tube used in the current region.

l Tube Length: The length of capillary.
These are only default sizes, you will be able to change these figures when you run the Pipe Network Wizard,
and in the project pipe view.

7.7.3 The Simple Pipe Wizard Tab of the Application Defaults Dialog

Figure 7-9: The Simple PipeWizard tab of the Application Defaults Dialog
This dialog lets you configure the default settings for the simple pipe wizard. For further details refer to The
Simple Pipe Screen of the PipeWizard.

l Number of bends before the first hole: The default number of bends before the first hole in the pipe.
l First Hole Position: The distance of the first hole from the start of the pipe network.
l Hole Separation: The default distance between holes.
l Total Pipe Length: The default distance for unbranched pipes.
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7.7.4 The Simple Branch Wizard Tab of the Application Defaults Dialog

Figure 7-10: The Simple Branch tab of the Application Defaults Dialog
This dialog lets you configure the default settings for the simple branched pipe wizard. For further details refer
to The Simple Branch Screen of the PipeWizard.

l Number of bends before the first branch : The default number of bends before the first branch in the
pipe.

l First Hole Position : The distance of the first hole from the start of the pipe network.
l Hole Separation : The default distance between holes.
l Section 3 Length : The length of the third section of pipe.
l Section 2 Length : The length of the second section of pipe.
l Section Length : The length of the first section of pipe.
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7.7.5 The H Configuration Wizard Tab of the Application Defaults
Dialog

Figure 7-11: The H Configuration tab of the Application Defaults Dialog
This dialog lets you configure the default settings for the H configuration pipe wizard. For further details refer
to The H Configuration Screen of the PipeWizard.

l Number of bends before the first branch: The default number of bends before the first branch in the
pipe.

l First Hole Position: The distance of the first hole from the start of the pipe network.
l Section 3 Length: The length of the third sections of pipe.
l Section 2 Length: The length of the second sections of pipe.
l Section Length: The length of the first section of pipe.
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7.7.6 The Multiple Branch Wizard Tab of the Application Default Dialog

Figure 7-12: TheMultiple Branch Configuration tab of the Application Defaults
This dialog lets you configure the default settings for theMultiple Branched pipe wizard. For further details
refer to TheMultiple Branch Screen of the PipeWizard.

l Number of bends before the first branch: The default number of bends before the first branch in the
pipe

l First Hole Position: The distance of the first hole from the start of the pipe network.
l Hole Separation: The default distance between holes.
l Section 5 Length: The length of the fifth sections of pipe.
l Section 4 Length: The length of the forth sections of pipe.
l Section 3 Length: The length of the third sections of pipe.
l Section 2 Length: The length of the second sections of pipe.
l Section Length: The length of the first section of pipe.
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7.7.7 The Group Types Dialog
To access this tab, select Tools | Group Types.

Figure 7-13: TheGroup Types dialog
The use of groups is an advanced design topic that should only be used if you have received Xtralis-
accredited training.

l Max Target Aggregate Sensitivity: The upper limit of smoke detection for the group of holes.
l Min Target Aggregate Sensitivity: The lower limit of smoke detection for the group of holes.
l Max Target Balance: The lower limit of acceptable sample hole balance.
l Target Suction Pressure: The lowest level of acceptable suction pressure for any sample point in the
group.

7.7.8 The Preferences Dialog
To access this dialog, select Tools | Preferences.

Figure 7-14: Systems Defaults
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7.7.9 The System Tab of the Preferences Dialog
Changing any of the settings on this tab will require ASPIRE to be restarted to take effect
This tab allows you to configure:
Pipe Parts Collection (or region)

l Asia Pacific
l Europe
l American

Units
This setting allows you to toggle the interface between Imperial (US) andMetric length and temperature units
when using the American region.
Language
You can select the language with which you would like to operate ASPIRE.

7.7.10 The Project Defaults Tab of the Preferences Dialog
This tab allows you to set defaults for future projects.
Enforced Limit
This setting allows you to apply limits from EN 54-20 or UL or use your own limits.

l Custom:All limits are to be set by you.
l EN54-20: This specifies by hole sensitivity and transport time limits.
l UL:Specifies hole sensitivity limits.

Altitude:Specifies the default altitude for future projects.
Hole Sizes:Specifies the default hole sizes for the current units.
Installer:Default name for the installer.
Calculated By:Person carrying out the calculation; usually the designer.
These settings will be applied to all future projects.

Figure 7-15: The Project Defaults Tab
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7.7.11 The General Tab of the Preferences Dialog

Figure 7-16: Edit Preferences Dialog
This tab contains settings that allow you to customize the ASPIRE user interface.
Auto-save
Auto-save will periodically save your design to the file aspireAutoSave.asp so that if ASPIRE crashes you
can still retrieve your design work. The design is only saved if it has changed since the last user save.
The following fields control the Auto-save behavior:

l Auto-save enabled:Enables/Disables the auto-save function.
l Auto-save period (minutes): The interval (in minutes) between auto-save events.
l Keep the last auto-saved version:When checked it will force ASPIRE to create a new backup file
every time that ASPIRE starts. This avoids ASPIRE clobbering the auto-save file if you restart it
straight after a crash but it may also build up a large number of files in your program data area.

l Auto-Save Location: The location where the files are saved.

General Settings
Calculate flows on loading file:When a file is loaded flow calculations will be performed for all detectors if
this option is checked. This option is enabled by default.
Save reports in project file folder:By default all reports are written as HTML files to the ProgramData folder
C:\ProgramData\Xtralis\Aspire. When this option is checked HTML files will be written to the same folder as
the ASPIRE file and given the same namewith a suffix to indicate the type of report. For example, if we were
to generate an IDP report for the ASPIRE fileHeadOffice.aspire, the generated report would beHeadOffice_
IDP.aspire.
Note: The ProgramData folder is hidden by default onWindows 7. To view and access it go toControl

Panel > Appearance and Personalization > Folder Options > Show hidden files and folders and
click on the radio buttonShow hidden files, folders, and drives.

Tooltip delay (ms): The time that tooltip messages will stay on the screen. This can be extended out to
10000 (ie 10 seconds). The default is 4000ms.
General warnings
When deleting detectors, pipes and doing several other actions you are now given the option to disable the
standard warning. If you do that then you will see an entry here that will let you re-enable that warning should
you wish to do so.
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8 Configuring Your Applications and Defaults
The factory default settings used when you first start the software are designed tomeet Xtralis standards.
These standards are typically more demanding thanmany local codes and standards. You will need to check
and configure the default values to suit the local codes and standards before designing the customer site.
You will also want to configure the default settings to suit your installer and application requirements. Once
these are configured you can be confident that the software will accurately accept designs whichmeet the
specific requirements of your customer site.
Changing the Defaults to Comply with Local Codes and Standards
The default criteria of ASPIRE may not meet the parameters required by your local fire codes and standards.
Before you start building pipe network designs for customers youmust check that the settings will be suitable
for the customer environment. Failure to do somay result in ASPIRE 'approving' a design, and producing a bill
of materials, which fails to meet local codes and standards.
Refer to The Detector Tab of the Application Defaults Dialog for instructions on how to change the default
criteria.
Changing the Defaults to suit your Installer
If your installation crews are limited to using drill pieces of certain sizes then edit the defaults so that ASPIRE
will only offer you solutions which comply with these restrictions. Refer to The Preferences Dialog for
instructions on how to change the default project settings.
Creating Custom Applications
If you are regularly designing a particular type of building, say a warehouse, youmay wish to set up your own
set of defaults to suit this environment. To configure a set of application specific defaults, refer to The
Application Defaults Dialog.
Copying or Distributing Defaults
Once you have created a set of defaults for a specific environment you can save and send them to other
people, to ensure that everyone in your organization is using the same set of defaults.
To distribute your set of defaults, copy the default file you have created in the following directory and distribute
it as required.

l C:\ProgramData\Xtralis\Aspire\ApplicationSettings
l C:\ProgramData\Xtralis\Aspire\ApplicationSettings
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9 Example: How to Use ASPIRE
The following section shows an example of setting up and troubleshooting a detector and pipes to obtain an
acceptable configuration, and to achieve EN54-20 classification. The example used here is of a VESDA VLP
detector with two straight pipes of 50m long, and two straight pipes of 40m long.
The 3D view for the detector with four pipes (below) shows the 3D view of the detector and pipes after clicking
theCalculate button. The pipes sections are colored green where the values are acceptable, and red where
they are unacceptable. TheGeneral tab shows that themanifold pressure is too low, and the group details tab
shows that the balance is unacceptable.
The aspirator speed was increased to 3600 rpm, and theAutobalance button clicked. After Autobalancing,
the hole sensitivities are colored green (Figure 9-2), indicating that the values are acceptable.
The Sampling Point Sensitivity tab shows that to achieve EN54-20 Class C, a detector threshold of 0.213 is
needed. This value is less sensitive than the current value of 0.200, so the detector is compliant.
When the display threshold checkbox is checked for Action Threshold (Class B), themaximum transport time
is reduced to 90 seconds (refer to Achieving EN 54-20 Compliance), and the values for the pipe sections are
red (The red figures indicate that the detector has achieved EN54-20 Class C but not Class B). The EN 54-20
Class Achieved box shows that Class C has been achieved.
TheApply button was clicked and confirmed, and theCalculate button was clicked. The numbers change to
green, and there are no red crosses on tree view (After the Detector Threshold needed (to achieve target
sensitivity) is applied, the detector has achieved EN54-20 Classes B and C). The detector now complies with
EN54-20 Classes B and C.

Figure 9-1: The 3D view for the detector with four pipes
Note: Pipe sections shown in red are unacceptable.
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Figure 9-2: The Sampling Point Sensitivity tab shows that the detector has achieved EN54-20 Class C
classification

Figure 9-3: The red figures indicate that the detector has achieved EN54-20 Class C but not Class B
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Figure 9-4: After the Detector Threshold needed (to achieve target sensitivity) is applied, the detector has
achieved EN54-20 Classes B and C



VESDA ASPIRE Product Guide VESDA by Xtralis

56 www.xtralis.com

This page is intentionally left blank.



VESDA by Xtralis VESDA ASPIRE Product Guide

www.xtralis.com 57

10 FAQs
10.1 Pipe Layout
Question: I made amistake while inputting data into the pipe wizard, how can I correct the design?
Answer:Click on the pipe you have created in the tree view (or 3D view) and edit it manually.
Question:Can an end cap be a capillary drop?
Answer:You can get the same effect by, simply placing a capillary just before the end-cap and then changing
the end cap to a ‘closed’ end cap.
Question:What do I do when the "total pipe length" is red?
Answer: If the "total pipe length" is red in ASPIRE, this means that:
This pipe is longer than Xtralis recommends for this detector based on detailed testing of the detector
aspirator.
Some recommended actions to resolve this are:

l Upgrade to a higher performing detector
l Split the pipe into two shorter pipes.
l If you are already using a VEU detector, consider redesigning the system to use additional detectors
l Check the area coverage is within the regulatory limits.

ASPIRE allows you to create designs that exceed Xtralis recommended limits for the VEU, VEP, VLP or VLS
detectors. In this case, youmust verify that the performance of the pipe network is within acceptable
customer and regulatory requirements.
Question: Is it possible for a pipe not to have an end cap in an ASPIRE MODEL?
Answer: Theremust always be an end cap, but you can represent a closed pipe by using a closed end-cap
(with a hole size of 0mm).
You should never use an end-cap with a very large hole size because then your system will not be able to pick
up a break in the pipe network.
Question:Can I model return pipes with ASPIRE?
Answer: ASPIRE now models the pressure drop across the return pipes. You need to enter the total length
and diameter of your return pipe on the detector’s General tab as the Exhaust length and Exhaust diameter.
Question: In the pipe view, how can I change a hole to a capillary?
Answer:Select the relevant pipe section in the tree, double click on the ‘Hole’ cell, from the Type column and
change it to a capillary.
Question: I can’t change pipe assignments without first deleting them. What should I do?
Answer:Presumably the changes that you refer to are adding and removing joins and bends in a pipe. It is
possible to both insert new bends, Tees etc and also to remove them as described below.
To insert the bends, Tees or other items:

l Select the pipe segment in the tree.
l Select the insert position (on the table) then click on the item in the palette toolbar. ASPIRE will insert
the itemmid-way between the selected item and the previous item.

l Check the item distances are correct for the new item and the following item.
To delete an item:

l Select the pipe segment in the tree.
l Select the item to delete in the table.
l Select the Delete toolbar button (the red cross) to delete. The distance of the deleted item would be
added to the distance of the next item.

l Check that the item distance for the following item is correct.
Question:How can we change the order of a pipe?
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Answer:You can change the order of pipes within a detector using drag and drop on the tree. The drag and
drop allows items to be reordered under their parent item but does not allow items to bemoved to another
parent.
Question: Is it possible to copy pipes and/or detectors within ASPIRE?
Answer:You can copy and paste pipes, as long as the detector has not reached its pipe limit. You can copy
/paste pipes and detectors between different instances of ASPIRE as long as both instances are using the
same region and units settings.
If you hold the control (Ctrl) key downwhile dragging the detector it will duplicate the detector where you do
the drop.
You can also duplicate a detector by selecting it, copying it to the clipboard (using the copy toolbar button or
using Edit->Copy menu or Ctrl-C keyboard shortcut). Then select the project on the tree and paste the
detector into the project (by clicking the Paste Insert toolbar button or using Edit->Paste Insert menu or Ctrl-I
keyboard shortcut).
You can copy a pipe similarly to the detector by doing drag and drop with the control (Ctrl) key down.
You can also copy a pipe by selecting it, copying it to the clipboard. Then select the destination detector and
paste insert. The paste insert function will be disabled when the detector’s pipe limit has been reached.
Question:How could I copy one pipe over another?
Answer:Select the original pipe then click on the copy icon. Select the destination pipe then click the paste
button. ASPIRE will replace the destination pipe with that from the clipboard when you click OK to proceed.
Question:How do I delete a pipe section or Tees and Branches?
Answer: To delete a pipe section, select it on the tree and then use the Edit > Deletemenu. You can also right
mouse click and select Delete from the context menu. ASPIRE will then delete the pipe section and replace
the branch at the head of the section with a bend or elbow.
You can delete a branch or Tee if the secondary inlet only contains one sample point. If the inlet contains more
sample points then you will first need to delete one of the pipe sections which will replace the branch with an
elbow as described above. You can then delete this elbow by selecting the pipe section in the tree, selecting
the elbow in the table and using the Delete toolbar button (the red cross).
Question:A field in the pipe wizard is dedicated to ambient pressure. How do I make sure I enter in the right
value for the application?
Answer: If there are no airtight doors in the pipe or detector areas set this value to zero (0). If there is fan
forced air or air doors fitted check with buildingmanagement for the air pressure specified in the air
conditioning floor plans.
Question:How do I change units to imperial, the field is greyed out?
Answer:Only when Pipe type = American do you have the option to change between Imperial andMetric
units. Bring up the Preferences window using the Tools > Preferences menu and change the Units field to US.
Save and restart ASPIRE.
Question: I would like to view all possible hole size choices how can I do this?
Answer:Click on the Project at the root of the tree and the hole sizes are listed in the details pane.
Question:How do I choosemy local pipe?
Answer:Contact your local Xtralis office or check your local codes and standards.

10.2 3D View
Question:How do I invert my detector so that it shows up correctly on the 3D view?
Answer: To invert the detector you need to select it on the tree and then on theGeneral tab on the right pane
you will find an Inverted Detector checkbox below the group of properties on the right of the tab. Use this to
define the detector orientation.
Question:What can I do if I get themessage ‘System does NOT support 3D graphics’?
Answer:ASPIRE uses JavaFX for its 3D graphics. The hardware requirements are specified
http://docs.oracle.com/javafx/2/system_requirements_2-2/jfxpub-system_requirements_2-2.htm
To use the 3D view you need to run on a computer that has this capability.

http://docs.oracle.com/javafx/2/system_requirements_2-2/jfxpub-system_requirements_2-2.htm
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Question:How could I see what I have just created?
Answer: ASPIRE provides live 3D view updates of detectors so you need to select a detector or an element
of a detector for the 3D view to know which detector to show you.

10.3 Flow Calculations
10.3.1 Balance
Question:Why is it important to have a balanced pipe network and how is this achieved?
Answer:A balanced system is one where there is similar flow through each sampling hole so that the entire
protected region is beingmonitored uniformly. Wewant to avoid networks which have dead regions that are
poorly monitored and we also want to avoid false detections by regions with are overly sensitive to smoke. In
ASPIRE, the default flow balance is 70% (and this can be adjusted). This means that every sampling hole has
at least 70% as much flow as the best sampling hole.
So how dowe achieve similar flows through each sampling hole. A simple starting approachmay be tomake
all the holes the same size. However the flow rate through each hole reduces with distance of the hole from
the detector. To help achieve a balanced system, try increasing the sampling hole size as the holes get further
away from the detector. The Auto-balance tool will help locate a possible combination of hole sizes that meets
your balance constraint. If no such solution occurs then youmay need to use shorter branched pipes.
Question: Is perfect pipe network balance really necessary since the regulations only stipulate transport
time?
Answer: Transport time is certainly important but if a network is not well balanced then it means that there are
‘dead’ regions that are not being fully monitored and possibly regions that are overly sensitive that may cause
false detections. So both balance and transport time are important. Youmust ensure that the transport time
requirement is met and complies with the regulations and also verify that there is a reasonable overall system
balance.
Question:Can I change the acceptable thresholds for% balance?
Answer:Balance should be at least 70%. However, you can set your own acceptance level. To alter your
defaults see Tools > Application Defaults > Group > Target balance.
Question:Can I accept a pipe network design when some of the parameters are shown as red even after
optimising the ASPIRE design?
Answer: ASPIRE estimates the pipe network performance. Where parameters will ensure themost reliable
performance these are shown in green. Parameters appearing in red indicate that the network falls outside of
the recommended range. However, youmay still accept a design with red settings if the pipe network design
meets your installation and regulatory requirements. Contact your local Xtralis office should you require further
assistance.
Question:What causes AutoBalance to fail?
Answer:AutoBalance searches for a solution to your pipe design that has acceptable transport times to all
the holes, achieves reasonable flow rates and pressures at each hole and is balanced.
If the network is inherently unbalanced such as one that combines long and short pipes then it may be
impossible to satisfy all the constraints and so the only way then tomeet approved standards would be to
even out the pipe network so that all the pipes are of similar length.
With long pipes it is difficult to meet the required transport times for the holes at the ends of the pipe. The
options are generally to increase the fan speed or reduce the pipe length by relocating the detector.
ASPIRE may find a potential solution but still show some hole sensitivity values in red. This indicates that the
detector threshold (which drives the Aggregate Sensitivity) is not achievable for these holes. In this case
review the threshold levels and consider reducing them.
Question: I don’t like the changes that AutoBalance has made tomy pipe network and wish to undo them and
go back to what I had before I ran AutoBalance. How do I do this?
Answer: The AutoBalance changes can be reversed usingEdit > Undo.
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10.3.2 Calculation Parameters
Question:What is an acceptable transport time?
Answer:Most local codes and standards specify that the transport time cannot be longer than 90 seconds.
(Check your local codes for details). Xtralis recommends that the transport time should be around 60 seconds.
Remember that there can be additional delays once a fire panel is notified before an alarm is sounded so it is
important to keep the detector delay to aminimum.
Question:What can I do if the detector flow rate is too low?
Answer:You can either try to adjust the pipe network tomatch the detector or match the detector to better
match the network.
Where possible try usingmore pipes of shorter length. Alternatively, try using larger holes, but be aware that
this will tend to unbalance your system.
You can enhance the detector by increasing the aspirator speed (applicable only to detectors with adjustable
aspirator speed). If that is still insufficient then select a higher performing detector.
Question:What does it mean when the sample hole sensitivity is displayed in red?
Answer: The hole sensitivity is an indication of how high the smoke concentrationmust be at the hole in order
to cause the detector to alarm. When the sample hole sensitivity is shown in red it indicates that the smoke
coming through that hole will be diluted toomuch by other air flows to trigger the detector.
To resolve this issue the Fire threshold setting can be reduced or the Target Hole Sensitivity setting on the
Group tab of the Application Defaults can be adjusted.
Question:Why is the hole sensitivity shown as red above 6.092%obs/ft or 20%obs/m?
Answer: Themaximum target aggregate sensitivity allowed in ASPIRE is 6.092% obs/ft or 20% obs/m. This
is the least sensitive that a point detector is allowed to be by any regulatory body. Given that sampling points
are often discussed as replacements for point detectors, this constraint ensures compliance. If it is necessary
for the designer to install a system that does not meet the criteria, the designer must verify that the
performance of the pipe network is within acceptable customer and regulatory requirements.
Question:How do I find out what variables mean?
Answer:Most of the variable fields have a tool tip that explains their meaning.
Question:Can I export the calculated data in pipe table data to Excel?
Answer: ASPIRE supports exporting data from any table to Excel. To do this select a row or cell in the table
and just press Ctrl-Shift-C (orEdit > Copy All) to copy the entire table to the clipboard. Then paste it in
Excel.
This will also include hidden columns or rows.

10.4 IDP
Question: I only want to print the pipe data. How do I do it?
Answer:You can select the preferred pipe then select the print IDP function to print the information related to
the selected pipe. If the detector is a Scanner then Scanmode data for the pipe will also be printed.
Question:How can I store a reference to the original drawings for my network?
Answer:Use the Notes field on the Project or Detector in the tree.
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10.5 Installation
Question:With which operating systems is ASPIRE compatible?
Answer:Microsoft Windows 7 and 10.
Question:Do I need Administrator rights to use ASPIRE software onmy PC?
Answer:You only need Administrator rights to install ASPIRE. For older builds (before build 3950) you will
also need it to register the software. Once you have done this you can use ASPIRE without being logged in as
an Administrator

10.6 Support
Question:Where can I obtain part numbers?
Answer:Contact your local distributor or Xtralis office to request the price list or sales brochure for your
product model number.
Question:Are there any specific training courses for maintenance and troubleshooting?
Answer:All Xtralis fire systems should be installed, configured, commissioned andmaintained by an Xtralis
accredited person.
Question:How do I test the Xtralis fire system after installation?
Answer:Only Xtralis accredited personnel are permitted to install, configure, commission andmaintain
Xtralis products. TheMaintenance section of the System DesignManual contains performance tests for this
purpose. Local regulations should be checked for commissioning requirements. Customers may also have
predefined requirements. All results should be recorded and signed off by commissioning staff, the end user
and a local fire approval inspector. These results should also be kept on record.
Question:Where do I obtain the ASPIRE Product Guide?
Answer: ASPIRE contains a complete online help file.
Question:Where do I obtain ASPIRE?
Answer: It is free for download from www.xtralis.com.

http://www.xtralis.com/
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T piece 24
type 4, 37
wizard 7-8, 37-42, 57

pipe section 35
pipe summary 34
pipe summary tab 27
pipe view 8, 31, 57
pipe wizard 37
pressure

absolute 26
ambient 42
atmospheric 42
manifold 26

print 60
problems 15
project 7-8, 17-18, 34, 49, 58, 60

add detector 7
rename detector 7

project tools 35
project view 25

R

red 8, 18, 34, 53, 57
region 49
running ASPIRE2 5

S

sampling point 24
sampling points 8
save 7, 9, 51
save as 9
sector flow 27
sector pressure 27
sensitivity 8, 11, 13, 15-16, 26, 53, 59
shortcut toolbar 21, 23
site survey 3, 8, 11
suction pressure 27-28
support 61
system defaults 7-8, 21, 49
system specification 5

T

target aggregate sensitivity 28
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target balance 28
target hole sensitivity 11, 16, 28
target suction pressure 28
temperature 26
threshold 4, 16, 34, 53
toolbars 21, 23
tools menu 21
training 61
transport time 7, 11, 15, 26-27, 53
tree view 8, 17-18, 57

U

unit of measure 49
updating ASPIRE2 5
upgrading ASPIRE2 5

V

version of ASPIRE2 22
view menu 21
views 25
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